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Troubleshooting FTE Reports
Part Two 

The Ohio Department of Education funds development of EMIS training materials 
as part of the EMIS Alliance grant. There is an expectation that ITCs will utilize these 
materials in training provided to your districts. That said, there are restrictions on 
use of the EMIS Alliance materials as follows: Materials developed as part of the 
EMIS Alliance program must be provided at no cost to your training participants. If 
you utilize the EMIS Alliance training materials – in whole or in part – you must not
charge participants a fee to attend the class where the materials are used. Likewise, 
you may not use the materials or any portion thereof in any event where a fee is 
charged to attend. Exceptions must be approved in writing by the Department of 
Education in advance of scheduling/promoting any event which may violate these 
restrictions.

Questions regarding appropriate use of EMIS Alliance materials, or requests for 
exception to the restrictions noted above, should be directed to Melissa Hennon 
[Melissa.Hennon@education.ohio.gov].
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Outline

• Accessing and Preparing Data Collector FTE Reports 

• Reviewing FTE Summary Reports

• Understanding FTE Daily Summary Reports

• Understanding how FTE Reports align with payments
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FTE Reports 
• Traditional, JVSDs, and ESCs 

• Beginning of Year Student collection 
• Midyear Student collection 
• End of Year Student collection 

• Community schools and STEM schools
• SOES Beginning of Year Student collection 
• SOES End of Year Student collection 

• Collections must be processed by ODE for reports to be 
generated

• FTE Reports use data from the Calendar collections and can 
also use data from the Staff and Course collections
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Accessing and Preparing Data 
Collector FTE Reports 
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Level 2 Reports 
FTE Reports are available in the Level 2 Reports link 
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Generate and Open Level 2 Reports

7

Select “Show Reports”

FTE Level 2 Reports 
• (FTES-001) FTE Total by Fund Pattern

• (FTES-002) FTE Total by Student and Fund Pattern

• (FTES-003) FTE Total by Student 

• (FTES-004) FTE Summary of Students with Adjustments 

• (FTES-005) FTE Daily Summary Report – Students District is Educating

• (FTES-006) FTE Daily Summary Report – Students Initially Funded at District

• (FTES-007) FTE Daily Summary Report – Transfers

• (FTES-008) Enrolled ADM FTE Summary 

• (FTES-009) FTE Subgroup Summary – Non-Transfers 

• (FTES-010) FTE Subgroup Summary – Transfers 
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Your LEA may not receive all
reports listed on this slide 
based on your student 
enrollment situations
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Reviewing the FTE Summary 
Reports 

9

Open the FTE Summary Reports
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Most LEAs will receive these four summary reports
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FTE Total by Fund Pattern (FTES-001) 

Summary by fund pattern with summed original and summed 
adjusted FTEs (not by Inclusion Code)
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FTE Total by Student and Fund Pattern (FTES-002)

Summary by student and fund pattern with summed original 
and summed adjusted FTEs
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FTE Total by Student (FTES-003) 

Summary by student with summed original and summed 
adjusted FTEs (regardless of FTE Fund Pattern Code)
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FTE Summary of Students with Adjustments (FTES-004) 

Summary by student with adjustments with summed original 
and summed adjusted FTEs including the difference
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Quick Check
• Are you reviewing the FTE 

Summary Reports often?

• Have you tried saving the reports 
to compare to an updated set of 
reports?

• Are you sharing these reports with 
others in your district? 

FTE Summary Reports can be 
used to provide a high-level 
view of student FTE data as 
well as multiple student level 
views. The reports can aid in 
data comparisons based on 
fund patterns, student totals, 
and student adjustments. 
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Understanding the FTE Daily 
Summary Reports 
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FTE Daily Summary Reports
• Contain student FTEs calculated from EMIS data that was processed at ten 

specific times

• Should be reviewed often to identify fluctuations in the number of FTEs 
being generated from specific submissions

• Contain result codes that are not an indication of an error but rather 
identify student education/funding situations

• Contain FTE totals separated by unique combinations of 

17

• Special Education Category Code 
• English Learner Category 
• Gifted Identified Code

• Result Code
• Grade Span Code 
• Economic Disadvantagement Flag

Open the FTE Daily Summary Reports

18

LEAs will have up to three FTE Daily Summary Reports 
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FTE Daily Summary Reports, cont’d

• (FTES-005) FTE Daily Summary Report - Students District is 
Educating
• Contains FTE totals for students the LEA receiving the report is educating 

• (FTES-006) FTE Daily Summary Report - Students Initially Funded 
at District
• Contains FTE totals for students the LEA receiving the report is initially 

funded

• (FTES-007) FTE Daily Summary Report – Transfers
• Contains FTEs by student situation whose funding is transferred in and 

out from the LEA receiving the report
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FTE Run Dates

• All three Daily Summary Reports contain the same 10 Run Date columns

• Most recent FTEs are to the left and prior FTEs are to the right
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FTE Run Dates, cont’d
Look for fluctuations in the FTE values as these could affect payments

21

1. Select the blank cells below the 
FTE values and then select AutoSum 
from the Formulas tab to help 
identify fluctuations

2. The most recent data 
processing 
caused a significant drop in FTEs

Error Severity Codes

Error Severity looks at the Thirty Day Average value and 
compares it to the value from the Latest Run to draw attention 
to differences that may be of concern

• The Fatal (F) Error Severity Code indicates a drop from the Thirty 
Day Average value to zero

• Critical (C) indicates a decrease of 10% or more (but not to zero) in 
the Latest Run 

• Warning (W) indicates a decrease of 5% to 10% but not to zero or 
an increase of 20% or more
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Error Severity Codes, cont’d

This example contains a Critical Error Severity Code due to a 
decrease in FTE between the latest run and the thirty-day average

23

Critical (C) indicates a decrease of 10% or 
more (but not to zero) in the Latest Run 

FTES-005 Students District is Educating

• Includes FTEs for students the LEA is educating regardless if 
the district is initially funded or if the funding will transfer to 
another LEA

• Result Code is FT0100 – Students LEA is educating
• This is the only result code on the FTES-005 Report

• Can appear for any LEA type 
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FTES-006 Students Initially Funded at District
• Includes FTEs of students for which the LEA is initially funded

• Generated for traditional districts, JVSDs, Community 
Schools, and STEM Districts 

• Contains up to seven different Result Codes indicating the LEA 
is initially funded and breaks down transfer information by 
student situation
• Each row on the FTE Detail Report will count in only one result code

• JVSDs, Community Schools, and STEM Districts receive only Result 
Code FT0110 on their report

• Displays FTEs as initially funded, positive amounts

25

FTES-006 Initially Funded Result Codes

• FT0110 – Initially funded, no transfer

• FT0111 – Preschool students initially funded, transferred 
to the ESC

• FT0112 - Open Enrolled Preschool Students Initially 
Funded at the LEA and Funds Transferred to Another 
District

• FT0113 - Preschool Students Initially Funded at the LEA 
Transferred to a CBDD 
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FTES-006 Initially Funded Result Codes
• FT0114 - Initially Funded at the LEA Transferred to a JVSD

• Used for Contract Career Tech transfers from the sending district 
to the JVSD

• FT0116 - Initially Funded at the LEA Transferred to Another 
District
• Used for special education cooperative students 

• FT0119 – JVSD/Compact 20% counted in sending district’s 
enrolled ADM
• Appear on sending LEA’s FTE Detail with inclusion code = PART
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FTES-007 Transfers 

• Contains FTEs that will either transfer in or out from the LEA 
receiving the report 

• Displays FTEs that transfer in as positive amounts and FTEs 
that transfer out as negative amounts

• Can be generated for any LEA type 

• Includes FTEs for students who are
• in preschool open enrollment situations

• in specific non-open enrollment situations

• preschool students attending an ESC

28

27

28



3/19/2023

15

FTES-007 Transfers Result Codes

• FT0150 – Preschool open enrolled in, initially funded 
elsewhere and funding transferred to educating LEA (positive 
amount)

• FT0160 – Preschool open enrolled out, initially funded then 
funding is transferred to the educating LEA (negative amount)

• FT0170 – Non open enrolled in, initially funded elsewhere then 
funding is transferred to educating LEA (positive amount)

• FT0180 – Non open enrolled out, initially funded then funding 
is transferred to the educating LEA (negative amount)

29

FTES-007 Transfers Result Codes, cont’d

• FT0210 – ESC Preschool student received from the resident 
district or a non-open enrolled district that is not the resident 
district; funding is transferred to the ESC from the district 
(positive amount)

• FT0220 – Preschool students sent to an ESC from the resident 
district or from a non-open enrolled district that is not the 
resident district; funding is transferred from the district to the 
ESC (negative amount)
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Quick Check
• Are you checking the Daily 

Summary Reports often to avoid any 
negative impacts on FTE funding?

• Do the numbers of FTE generated 
for the various attending situations 
align with your population of 
students? 

• Are you sharing these reports with 
others in your district? 

FTE Daily Summary Reports 
are helpful to identify 
fluctuations in FTEs that could 
affect funding. They can also 
be used to follow the flow of 
FTE funding based on student 
situations.

31

Understanding how FTE 
Reports Align with Payments 
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FTE Reports Level 2 versus Archived 

• LEAs receive FTE reports as Level 2 and Archived versions

• What is the difference? 
• Level 2 FTE reports in a closed collection contain the data last 

processed for that collection 

• Level 2 FTE reports in an open collection contain the most recently 
processed data 

• Archived reports are generated when data is pulled for payments

33

FTE Reports Level 2 versus Archived, cont’d 

How are the FTE reports used? 
• Level 2 FTE reports in a closed collection can be used to provide a 

historical view of data for that collection

• Level 2 FTE reports in an open collection should be used to verify 
current data submissions in preparation for data to be pulled for a 
payment and in preparation for the close of the collection 

• Archived FTE reports can be used to align data with historical and 
current payments
• Aligning archived FTE reports to a current payment will be the focus of 

this section
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Archived FTE Reports that Align with Payments 
• In this series of slides, we will demonstrate how reports from 

the Archive Tab align with payments for various LEA types
• (FTED-001) FTE Detail Report

• (FTES-008) Enrolled ADM FTE Summary 

• (FTES-009) FTE Subgroup Summary – Non-Transfers 

• (FTES-010) FTE Subgroup Summary – Transfers
• (CTEA-000) CTE FTE Detail 

• Your LEA may not have all FTE reports 

• We will explain a very basic process that will provide an 
understanding of how the data is used for payments

35

Archived FTE Reports Aligned with Payments

36

To match report data with a payment, use FTE Reports from the Archive Tab

Add a date in the filter to narrow results, 
remember, this is the data pull date

Leave Collection Request filter 
set to “All” to receive both FTE 
and CTE FTE Reports 
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Archived Report Names 
There can be other reports in the Archive with similar names, 
be careful to select the correct reports 

• Traditional Districts and ESCs receive two payments per month
• Month_FY##_No1_TRAD_Payment 

• Month_FY##_No2_TRAD_Payment 

• Community Schools, STEM Districts
• Month_FY##_CS_Payment 

• JVSDs
• Month_FY23_JVSD_Payment 

• CTE FTE Reports, if your LEA has them will also be listed with the 
above names
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Archive Reports 
FTE and CTE FTE Reports are placed in the Archive when data is pulled for 
payment (reports listed below will align with the February #2 payment) 

• Typically, data is pulled two Mondays prior to payment

• Home > Finance & Funding > School Payment Reports
• State Foundation Payment Dates by Fiscal Year

38

For February #2 payment, 
data was pulled February 6th, 

while the payment date was 
February 17th
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Payment Reports 
https://reports.education.ohio.gov/finance/foundation-payment-report

39

1. Select LEA type, Fiscal Year and “Go”   

3. Select your LEA

2. Select Payment Date  - for this demonstration we will use 
February #2 for traditional districts and ESCs, and February 
for JVSDs, Community schools, and STEM districts

4. We will match Archived EMIS 
report data to some of the 
reports in the dropdown menu. 

Payment Reports Aligned with EMIS Reports 

• Traditional Districts, Community/STEM Schools, JVSDs
• Detailed School Funding Payment Report (SFPR) 

• Other Adjustments 

• Base Cost 

• Traditional Districts and ESCs 
• Preschool Special Education 

• Traditional Districts 
• Educational Service Center Deduction

• This is not a complete list of payment reports that contain 
EMIS data

40
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Current Year Data and Prior Year Data 
Archived Reports for February 2023 Payment(s)

• (FTED-001) FTE Detail Report
• Current year data 

• (FTES-008) Enrolled ADM FTE Summary
• Combination of three prior years data and the current year

• (FTES-009) FTE Subgroup Summary – Non-Transfers 
• Contains current year FTE data for students who are directly funded to the LEA, and is 

separated by subgroup

• (FTES-010) FTE Subgroup Summary – Transfers
• Contains current year FTE data for students who are funded via a transfer, and is 

separated by subgroup

• (CTEA-000) CTE FTE Detail 
• Contains current year CTE FTEs

41

Enrolled ADM

• What is Enrolled ADM? 
• A count of students that is adjusted based on attending situations 

• Can be verified using the Archived (FTED-001) FTE Detail Report 
for that payment 

• Can also be verified using the Archived (FTES-008) Enrolled ADM 
FTE Summary – Current year data row
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Detailed SFPR – Enrolled ADM and Special Education ADM 

43

This example is for a Traditional 
district but is similar to a Community 
School, STEM District, and JVSD report 

Using the “Archived FTE 
Detail to Detailed SFPR” 
workbook, you can 
view the students who 
are included in these 
numbers 

Enrolled ADM on Detailed SFPR – Traditional District 

44

Using the Archived FTE Detail report, filter on each combination of Fund Pattern Code and 
Inclusion Code, then sum the Adjusted FTE and enter it (all decimals) into the appropriate cell

Result will be the Enrolled ADM
This screenshot is from the Traditional tab
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Special Education ADM on Detailed SFPR – Traditional

45

This can also be broken down by special education 
category by filtering on each category 

Using the Archived FTE Detail report, filter on each combination of Fund Pattern Code 
and Inclusion Code, then sum the Adjusted Special Education CAT FTE and enter it (all 
decimals) into the appropriate cell

Result will be the Special Education ADM

This screenshot is from 
the Traditional tab

Multiple ADMs on Detailed SFPR – COMM/STEM 

46

Using the Archived FTE Detail report, filter on each combination of Fund Pattern Code and Inclusion 
Code, then sum the Adjusted FTE or Adjusted Special Education FTE and enter it into the 
appropriate cell

Result will be the Enrolled ADM, Career Tech at JVSD or CTPD, and Special Education ADM

This screenshot is from the COMM STEM tab
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Multiple ADMs on Detailed SFPR – JVSD

47

ADJUSTED FTE * 100% 0.00 Community School Student attending a JVSD for CT

ADJUSTED FTE * 100% 0.00 Resident of District A, attending District B (not OE) then to a JVSD

ADJUSTED FTE * 100% 0.00 Direct Enrollment to a Non-Jointure JVSD (OE) 

ADJUSTED FTE * 100% 0.00

Resident of District A, attending District B via OE then to a JVSD that is within the jointure of 

both A and B 

ADJUSTED FTE * 100% 0.00

Resident of District A, attending District B via OE then to a JVSD that is not within the jointure of 

either A or B 

ADJUSTED FTE * 100% 0.00 Students educated at a jointure JVSD (not OE or CT)

Total 0.00

ADJUSTED SPECED CAT FTE * 100% 0.00 Community School Student attending a JVSD for CT

ADJUSTED SPECED CAT FTE * 100% 0.00 Resident of District A, attending District B (not via OE) then to a JVSD

ADJUSTED SPECED CAT FTE * 100% 0.00 Direct Enrollment to a Non-Jointure JVSD (OE) 

ADJUSTED SPECED CAT FTE * 100% 0.00

Resident of District A, attending District B via OE then to a JVSD that is within the jointure of 

both A and B 

ADJUSTED SPECED CAT FTE * 100% 0.00

Resident of District A, attending District B via OE then to a JVSD that is not within the jointure of 

either A or B 

ADJUSTED SPECED CAT FTE * 100% 0.00 Students educated at a jointure JVSD (not OE or CT)

Total 0.00

JVNR FULL

FULL

Table 6: JVSD - Enrolled ADM
Fund Pattern Inclusion Code

CTCS FULL

LEA in bold is the entity who will see the Fund Pattern Code and Inclusion Code combination for 

the row.   (Open Enrollment = OE, Contract Career Tech = CT, District of Residence = DOR) 

LEA in bold is the entity who will see the Fund Pattern Code and Inclusion Code combination for 

the row.   (Open Enrollment = OE, Contract Career Tech = CT, District of Residence = DOR) 

OJVR FULL

OPID FULL

CTCS FULL

JVNR FULL

OJVD FULL

RGJV

Sum the following 

Line a: Enrolled ADM 

Table 7: JVSD - Special Education ADM

ADJUSTED FTE Enrolled ADM

ADJUSTED FTE Enrolled ADM

Line b: Special Education ADM

RGJV FULL

Sum the following Fund Pattern Inclusion Code

OJVD FULL

OJVR FULL

OPID FULL

Using the Archived FTE Detail report, filter on each combination of Fund Pattern Code and Inclusion Code, 
then sum the Adjusted FTE or Adjusted Special Education FTE and enter it into the appropriate cell

Result will be the Enrolled ADM and Special Education ADM

This screenshot is from the JVSD tab

Archived (FTES-008) Enrolled ADM FTE Summary 

48

Report contains 4 fiscal 
year’s data. We will 
use a formula to 
calculate Enrolled ADM 
on all four rows

Enrolled ADM for 
February #2 on slide 43

Enrolled ADM Formula for Traditional Districts 

Enter the formula into cell 
Q2 and copy down

COPY THIS FORMULA INTO YOUR FTES-008 Report 
=H2+I2*0.5+J2+K2+L2+M2+N2*0.2+O2*0.2
For JVSD, COMM, and STEM use 
=H2+I2*0.5+J2+K2+L2+M2

47

48



3/19/2023

25

Detailed SFPR Continued 

49

For these factors we will use the FTES-009 and FTES-010 on the next two slides 

Filter Archived FTE 
Detail Report on Fund 
Pattern Code OPDD 
and Sum Adjusted FTE

(FTES-009) FTE Subgroup Summary – Non-Transfers 

50

Columns K through Z will align with 
lines e-h on the Detailed SFPR  Note: If your LEA has an FTES-010 

Transfers report, you must include 
“Out” values – See next slide
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(FTES-010) FTE Subgroup Summary – Transfers 
Report includes students who are enrolled in Contract Career Tech or 
Special Education Cooperative Programs with FTEs transferred in or out 

51

Other Results Codes Include: 
FT0241 Contract vocational transfers in
FT0243 Special Education transfers in 

Include “out” FTEs from this report 
with those from prior slide

Combining the FTED-009 and FTED-010 FTEs

52

FTES-009 Report 

FTES-010 Report 

Include only transfers out

1. Using CTEs, combine CTE FUND CAT 1 from both 
reports to match to line g1  on the Detailed SFPR

2. Go back to slide 49 to match the FTEs 
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Base Cost

• Base Cost Enrolled ADM 
• Uses the larger of the prior year or trailing 3-year average

• Can be verified using the Archived (FTES-008) Enrolled ADM FTE 
Summary – Prior three years data rows

• Archived (FTES-008) Enrolled ADM FTE Summary 
• Combination of three prior years data and the current year

• Contains FTE data that is divided into categories

• First three rows contain prior three years data 

• Last row contains current year data at the time data was pulled for 
the payment 

53

Base Cost Report – Using FY22 Data 

54

This district’s Base Cost 
uses FY22 Enrolled ADM 
since it is larger than the 
trailing three-year average
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FTES-008 –Calculate Base Cost Using FY22 Data

55

We already added the formula 
to column Q on slide 48

This district’s Base Cost 
uses FY22 data on row 4

Base Cost Report – Using FY22 Data 

56

This is the same district that is 
using the FY22 Enrolled ADM 
to determine Base Cost 

Archived FTES-008 report data from the FY22 
row aligns to b4-b9 on the Base Cost Report 
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FTES-008 –Calculate Base Cost Using FY22 Data

57

Archived FTES-008 report data from the FY22 row aligns to b4-b9 on the Base Cost Report 

This section of the Base Cost is from the prior slide

For b6 multiply cell N4 x .20 then add to cell K4  

For b7 multiply cell O4 x .20 then add to cell L4  

For b4 multiply cell I4 by .50 then add to cell H4 

Base Cost – Payment Report using Average

58

This district uses the 
trailing three-year average 
since it’s higher than the 
FY22 Enrolled ADM

The next slide will demonstrate the average on the FTED-008 report  

Average these three numbers

57
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Archived (FTES-008) Enrolled ADM FTE Summary 

59

Average the 
Enrolled ADM 
for the three 
prior years 

Base Cost – Payment Report – More Averages 

60

For this LEA, since the average is used, an average will 
also be used to align to the data in b4 – b9. The next slide 
will demonstrate the average on the FTES-008 report  

Average these three numbers
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Base Cost – Payment Report – More Averages, cont’d 

61

This section of the Base Cost report is from the prior slide

Archived FTES-008 report data from the averaged row aligns to b4-b9.

For b4 multiply cell I7 by .50 then add to cell H7 

For b6 multiply cell N7 x .20 then add to cell K7  

For b7 multiply cell O7 x .20 then add to cell L7  

Drag the formula from cell Q7 to the left, to cell H7

Other Adjustments Report

62

To match to the Archived FTE Detail, filter 
to each combination of CTXX and SPCO 
with Inclusion Codes FULL and NONE 

1. Filter Archived FTE Detail - CTXX/NONE and SPCO/NONE match to Positive FTEs

2. Filter Archived FTE Detail - CTXX/FULL and SPCO/FULL match to Negative FTEs

Note - the “Enrolled FTE” column would include the ADJSTD FTE 
minus the ADJSTED SPECED CAT FTE for CTXX and SPCO students
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(FTES-010) FTE Subgroup Summary – Transfers 
Report includes students who are enrolled in Contract Career Tech or 
Special Education Cooperative Programs with FTEs transferred in or out 

63

Other Results Codes Include: 
FT0241 Contract vocational transfers in
FT0243 Special Education transfers in 

CTE and Spec Ed are in opposite 
positions on FTES-010  versus the 
Other Adjustments Report  

Other Adjustments Report and Archived FTE Detail  

64

Filter on Fund 
Pattern code 
PBDD on the 
FTE Detail 
Report 

1. On the FTE Detail Report, Filter on Fund 
Pattern Code PSOP 

2. Filter on Inclusion Code NONE for 
Open Enrolled In – Positive FTEs  

3. Filter on Inclusion Code FULL for 
Open Enrolled Out – Negative FTEs 

District to district preschool open enrollment 
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Preschool Special Education Report - Trad

65

Filter Archived FTE Detail 
Report to included only Grade 
level PS and Inclusion Code 
FULL.  Sum the Adjusted FTE

Filter by special education category as needed

Educational Service Center Deduction – Trad

66

This report shows special education PS students 
where both the ESC and district have reported to EMIS 
that they agree to transfer funds to the ESC

Filter traditional district’s archived 
FTE Detail report on PSET/FULL and 
PSIT/FULL  

Filter traditional district’s archived 
FTE Detail report on PSOT  
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Preschool Special Education – ESC

67

This report only shows special education PS 
students where both the ESC and district 
have reported to EMIS that they agree to 
automatically transfer funds to the ESC

Filter ESC Archived 
FTE Detail Report on 
Fund Pattern Codes 
PSET and  PSIT

This section contains one of many 
districts for this ESC. Add filters to 
Archived FTE Detail to drill down to 
individual students

District name(s) 
will appear here

Preschool Special Education – ESC , cont’d 

68

Filter ESC Archived FTE Detail 
Report on Fund Pattern Code PSOT 
to see individual students

District names will appear on the report 
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Quick Check
• Are you reviewing the Level 2 

versions of the FTE Summary 
Reports prior to data being pulled 
for payments? 

• Are you reviewing the Archived FTE 
Summary Reports to verify that all 
students are included as expected? 

• Are the reports being compared to 
payments to verify students are 
being funded correctly? 

Archived FTE Summary 
Reports contain data that 
align with School Finance 
Payment Reports (SFPR). It’s 
important for EMIS staff to 
understand how EMIS data is 
being used in the funding 
process. 

69

Resources
• Current EMIS Manual

• ODE Home > Topics > Data > EMIS > Documentation > EMIS Manual 

• Level 2 Report Explanations  
• ODE Home > Topics > Data > EMIS > Documentation > EMIS 

Validation and Report Explanations
• FTE Report Explanations (multiple) 

• School Payment Reports 
• Home > Finance & Funding > School Payment Reports

• Your ITC

• Your Area Coordinator

70
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71

Questions?
If you would like a certificate of attendance for this 

training, you must complete the below feedback 
form within 5 business days of this training

https://tinyurl.com/EA-District-Feedback

71

https://tinyurl.com/EA-District-Feedback
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